Introduction - The programming world of First Robotics Competition:

Every programmer has their own preferences that they feel are comfortable and/or that they support the best way to achieve the goal of their program. Some prefer to use Microsoft's Visual Studio as their IDE; some prefer Turbo Lite, some Boardland and other Programming Environments. Some prefer to use other programming languages; some C, some C++, JAVA, C#, PYTHON, PASCAL, ASSEMBLER and others.

FIRST Robotics Competition team programmers have the option to use either Intelitek's EasyC Pro program or Microchip's MPLab IDE in order to program their robot..
A rookie or 2nd year programming team will think to themselves which Development Environment should they use to create a code to make their team's robot do the specific functions the team has defined and/or will define later.

This article is my attempt to suggest FRC team programmers to use MPLab to code their robot or rather it's just an article about how MPLab works for FIRST.

What is raw code?
Raw code is the type of code where the code is written in its basic and most primitive form designed for the programming language (literally in the very first version of the language). Nothing is hidden or morphed in some way that all is actually there, but the user doesn't see it. It's all there.
Why use raw code?
Raw code is the closest form of orders that the compiler decrypts, meaning it will go over the compiling process faster.
Some programmers learn to program in the form of raw code IDEs and are used to it along the years. Most C and other language self guide books (and some teaching group books) work with raw code subjects in order to know how to work in the "most basic way".
Furthermore, if you write a working program with a raw code it makes you look like a pro. In fact, you might even consider yourself a beginner pro!

How to easily become a pro in MPLab:

So, if I have or haven't convinced you enough that raw code is a great method (used in MPLab), here's the guide to the new user on how to program your FIRST robot on MPLab.

The FRC Robot Controllers have a specific design to work with MPLab and EasyC Pro. The program that transfers your code, IFI_Loader, is related to Microchip, the creators of MPLab, therefore working with MPLab can be more effective(less downloads or installations). The closest and easiest way to get a code that can operate your robot in its most basic form is the FRC Default Code. 
Each year the FRC Default Code is available for download at www.ifirobotics.com/rc.shtml. Some times the code is updated to enhance the code and give more programming options to use with your robot, yet the same concept of the files and the codes running in the program are almost always the same each year.

Once you've installed MPLab, downloaded the FRC Default Code and inserted all the files into a single folder, you can start working with MPLab.
In order to open the Default Code:

1. Open MPLab IDE.

2. Go to File -> Open Workspace.

3. Browse your way into your FRC Default Code folder and open the single FrcCode.mcw file.

You should have 2 windows, an 'FrcCode.mcw' window and an 'Output' window. If you see those, you've made it to the Default Code. Wooho to you!

(If you receive an error when trying to open the file, it's probably because the path to your file has some non-English characters in its line, in example, C:\FIRST\תכנות\FrcCode2007\FrcCode.mcw.

"תכנות" is a non-English character(in a matter of fact, it's a Hebrew character). MPLab IDE does not allow non-English characters while working with it (Quite a shame, huh?). :-/
So just make sure you put your projects paths where there will be only English characters.)

Now before you really start working on the code, you should go over one more thing:

1. Go to Project -> Build Options -> Project.

2. make sure the Include Path and the Library Path are both looking at the correct path to those files(Library Path to mcc18\lib and Include Patch to mcc18\h). If the paths are not correct you will receive the following error in the output window when you will press the Build All:

"Error - could not find file 'clib.lib'."

If so, make sure it's in the correct path.

Le Voila! Your MPLab is ready! Give yourself a little credit for the fine job making your Development Environment ready for your team. ;-)

Now the fun part:

Programming in MPLab:

So, you want to start programming your robot, make it do some sweet stuff?

Well, first, you need to make sure you know the basics of programming in C language. That means understand simple input-output actions, loops and a bit of functions. Functions should be the farthest subject in C language you should learn in order to basically program in MPLab for FRC. It's all quite simple after going over the material and practicing it for a while.

Second, we suggest you follow this guide of how the Default Code works.

But, if you think you know the way the Default Code works and you're really eager to start coding, then head on to the Time to write your own code! section, pro!

How does the FRC Default Code work?
When you might see all those files in that window named by the project you're working in with all those Source Files, Header files and whatever the rest are, for the first time, you might ask yourself: "Where in the devil am I supposed to start writing my code???"

Well, let's try to ease your confusion and give you a short explanation of how the whole thing works. 
(Not interested in waiting? Skip over to Where do I write what? section. It's just the next section, not really far!)
Almost every code written (be it in FRC, FLL or any kind of other programs not related to robotics :-O )has a main section. In MPLab, the main section is the source file: 
 "main.c" 

In that file you'll see a total chaos of blue, green and black text all over the place. Relax. Blue text means that the order or variable is known to the compiler. Green text means that the compiler does not read those texts, it ignores it. Usually the green text is for you, the programmer, to write notices and other messages you want. The Black text is usually either a function or a variable that we gave it a name of our own, something that the compiler might not know unless you will include the header file in which the variable or function was defined.

So, what actually happens when the compiler reads this code?

void main (void)
{
#ifdef UNCHANGEABLE_DEFINITION_AREA
  IFI_Initialization();        /* DO NOT CHANGE! */
#endif
  User_Initialization();        /* You edit this in user_routines.c */
  statusflag.NEW_SPI_DATA = 0;  /* DO NOT CHANGE! */ 
  while (1)   /* This loop will repeat indefinitely. */
  {
#ifdef _SIMULATOR
    statusflag.NEW_SPI_DATA = 1;
#endif
    if (statusflag.NEW_SPI_DATA)      /* 26.2ms loop area */
    {                                 /* I'm slow!  I only execute every 26.2ms because */
                                      /* that's how fast the Master uP gives me data. */
      Process_Data_From_Mater_uP();  /* You edit this in user_routines.c */
      if (autonomous_mode)            /* DO NOT CHANGE! */
      {
        User_Autonomous_Code();        /* You edit this in user_routines_fast.c */
      }
    }
    Process_Data_From_Local_IO();     /* You edit this in user_routines_fast.c */
                                      /* I'm fast!  I execute during every loop.*/
  } /* while (1) */
}  /* END of Main */
Where ever it says that you shouldn't change, you really shouldn't change. Those areas are vital actions that make the robot start, switch modes or just do something. 

If you are really interested in what those actions do you should go to the header file where it is defined and read what it does. 

Sometimes trying to understand a whole process of calling a function in specific locations can take you from one file, to another and another. Hey, there's another. And another….another…is that another? ANOTHER?!?!?

*Ahem*

So, let's continue…

'User_Intialization();' – This function starts the robot and sends definitions to parts of the Robot Controller and starting orders. An example, at the very beginning of the code running in your robot, you don't want him to start moving immediately. That's why in that function there's a code line that defines that every PWM Output will send a neutral signal, meaning nothing should move.

Editing this function in the user_routines.c file is usually meant to define beginning values and for the Digital IO pins whether they should receive values from the component connected to them or whether they should send values to it. A further explanation of the function is expressed later on.
After the initialization and a not-to-be-changed code line there's a code line that says "while (1)". This loop line means that as long as 1 does not equal to 0 (which in our universe means always), the robot will do the following functions (after the '{' character). So what will happen is that after the initialization, the robot will enter the endless loop where it will do one of the following all the time until the robot's power is shut down:

'Process_Data_From_Mater_uP();' - this is the function where the robot works in the teleoperated mode (or in English, manual or driver mode). Further explanation, later.
if (autonomous_mode)            /* DO NOT CHANGE! */
      {
        User_Autonomous_Code();        /* You edit this in user_routines_fast.c */
      }

'autonomous_mode' is a global variable which receives a value from the Operator Interface. When the Operator Interface is connected to the competition box and the autonomous mode starts, it sends a signal to the OI, which sends a signal to the Robot Controller, the Robot Controller gives a signal to the microprocessor in it and gives a 1 value to the variable 'autonomous_mode' and the code line that says "if (autonomous_mode)" means (just like the 'while (1)') if variable 'autonomous_mode' does not equal 0 (equals 1), then do the following action(s).

The following action is the function User_Autonomous_Code().

This function is where the robot works in the autonomous mode (or in English, automatic mode). Further explanation later.

And last but no least, 'Process_Data_From_Local_IO();'
This function works in teleoperated mode and does fast actions. The function does actions without receiving new data from the microprocessor. In short, it's a very fast function that works without new data.
And that's it. Once you turn off the robot's power, the code won't work. Every time you open the robot's power, the robot initializes and then enters the endless loop of autonomous or teleoperated mode (or disabled mode).

So, that's the main part of the program. Now, we get deeper into the code, where you will be working most of the time in your code
Where do I write what?

'user_routines.c'

There's allot to talk about the following user_routines.c and user_routines_fast.c files, but I'll speaking of the functions that really matter.

'void User_Initialization(void)' – in this code area, you define the first values to the output/input pins on your Robot Controller, being the PWM Output, Digital I/O and Analog inputs.

/* FIRST: Set up the I/O pins you want to use as digital INPUTS. */
  digital_io_01 = digital_io_02 = digital_io_03 = digital_io_04 = INPUT;
  digital_io_05 = digital_io_06 = digital_io_07 = digital_io_08 = INPUT;
  digital_io_09 = digital_io_10 = digital_io_11 = digital_io_12 = INPUT;
  digital_io_13 = digital_io_14 = digital_io_15 = digital_io_16 = INPUT;
  digital_io_18 = INPUT;  /* Used for pneumatic pressure switch. */
    /* 
     Note: digital_io_01 = digital_io_02 = ... digital_io_04 = INPUT; 
           is the same as the following:
           digital_io_01 = INPUT;
           digital_io_02 = INPUT;
           ...
           digital_io_04 = INPUT;
    */
/* SECOND: Set up the I/O pins you want to use as digital OUTPUTS. */
  digital_io_17 = OUTPUT;    /* Example - Not used in Default Code. */
It's quite written already, but I'll try to simplify it even more. In this area you define which Digital I/O pins you want to be input pins, meaning that the Robot Controller will receive digital values from components connected to those Digital I/Os. If you define digital_io_01 to be used as an input, a component connected to Digital I/O number 1 will send digital values to the Robot Controller.

And so vice versa, digital_io variables that are defined as output will send values to components connected to that Digital I/O. 

When you define a digital_io variable as an output, you can also define the first value given to that Digital I/O by defining the value of the digital_io's alias, the rc_dig_out variables. (digital_io_10 = rc_dig_out10)
/* FOURTH: Set your initial PWM values.  Neutral is 127. */
  pwm01 = pwm02 = pwm03 = pwm04 = pwm05 = pwm06 = pwm07 = pwm08 = 127;
  pwm09 = pwm10 = pwm11 = pwm12 = pwm13 = pwm14 = pwm15 = pwm16 = 127;

As it says, it neutrals all the PWM Output pins. The Victor Speed Controller connected to those pwms will not send any movement value (forward or backward) to the connected motor.
Later on there's a green text area which says '/* Add any other initialization code here. */'. Have any other initialization codes to add? That's the place.

'void Process_Data_From_Mater_uP(void)'
In this function, the robot executes the code in the function in it's teleoperated mode. It receives data from the microprocessor in 'Getdata(&rxdata)' and executes the actions given defined at 'Default_Routine()'. Later on you can add more codes, such as outputs to be seen on your computer screen while checking your program (like the following code line: 

'printf("Port1 Y %3d, X %3d, Fire %d, Top %d\r", pwm01, pwm05, p1_sw_trig, p1_sw_top);'

In that area you can call your very own functions you have designed by yourself for your robot!

If you've defined other PWM Outputs for your engines, you'll need to redefine 'Generate_Pwms(pwm13,pwm14,pwm15,pwm16);' to the correct PWM pins you've selected.
'void Default_Routine(void)'

This function, as it has been told in the purpose of the function, is to perform default mapping of the inputs to outputs for the Robot Controller.
pwm01 = p1_y;
pwm02 = p2_y;   
pwm03 = p3_y;   
pwm04 = p4_y;   
pwm05 = p1_x;  
pwm06 = p2_x;   
pwm07 = p3_x;   
pwm08 = p4_x;   
pwm09 = p1_wheel; 

pwm10 = p2_wheel;   
pwm11 = p3_wheel;   
pwm12 = p4_wheel;

This area code is defined to take the analog values from your joystick and turn them into PWM values to the motors or engines or other components connected to those Victors connected to those PWM Outputs. You can define which Analog Input will be made into which PWM Output you desire. You may change pwm01 to receive the analog values of p1_wheel if you wish to do so (pwm01 = p1_wheel). It's up to you and your convenience. 

  *  This code mixes the Y and X axis on Port 1 to allow one joystick drive. 
  *  Joystick forward  = Robot forward
  *  Joystick backward = Robot backward
  *  Joystick right    = Robot rotates right
  *  Joystick left     = Robot rotates left
  *  Connect the right drive motors to PWM13 and/or PWM14 on the RC.
  *  Connect the left  drive motors to PWM15 and/or PWM16 on the RC.
  */  
  p1_x = 255 - p1_y;
  p1_y = 255 - pwm05;
  pwm13 = pwm14 = Limit_Mix(2000 + p1_y + p1_x - 127);
  pwm15 = pwm16 = Limit_Mix(2000 + p1_y - p1_x + 127);

Here's a very nice code has been written for you. It takes the x axis value and the y axis value from the joystick and converts it to wheels actions so that when you really turn your joystick right the robot will turn right, and if you push it forward it will really go forward. You may define which PWM variable you want to be connected to the right motor or left motor. 
Just be careful not to define the same PWM with something else or you'll get 2 inputs controlling 1 PWM Output!
  relay1_fwd = p1_sw_trig & rc_dig_in01;  /* FWD only if switch1 is not closed. */
  relay1_rev = p1_sw_top  & rc_dig_in02;  /* REV only if switch2 is not closed. */
  relay2_fwd = p2_sw_trig & rc_dig_in03;  /* FWD only if switch3 is not closed. */
  relay2_rev = p2_sw_top  & rc_dig_in04;  /* REV only if switch4 is not closed. */
  relay3_fwd = p3_sw_trig;
  relay3_rev = p3_sw_top;
  relay4_fwd = p4_sw_trig;
  relay4_rev = p4_sw_top;
  relay5_fwd = p1_sw_aux1;
  relay5_rev = p1_sw_aux2;
  relay6_fwd = p3_sw_aux1;
  relay6_rev = p3_sw_aux2;
  relay7_fwd = p4_sw_aux1;
  relay7_rev = p4_sw_aux2;
  relay8_fwd = !rc_dig_in18;  /* Power pump only if pressure switch is off. */
  relay8_rev = 0;

This default code maps the joystick buttons into relay outputs. Relays, being like Digital Output, just that the relay connected to the Spike Relay has 2 variables to control forward and backwards, so in a matter of fact, the Spike Relay has 4 binary values (1-1, 1-0, 0-1, 0-0). Usually these 4 binary values are used for 2 independent solenoids, lights or pumps. Some of these relays have been defined to work only when certain switches are not closed. The code line 'relay1_fwd = p1_sw_trig & rc_dig_in01;' means that relay1_fwd will receive a value of 1 if the port1 joystick trigger will be pressed and the switch connected to Digital Input 01 will not be closed (when it's closed the Digital Inputs value is 0 and is 1 when open) relay1_fwd will send a value of 1(0-1) to the Spike.

A few examples of custom relay mapping is the last 2 line which defined that relay8_fwd will receive a 1 when the switch connected to Digital Input 18 will be closed and relay8_rev will never receive anything except for 0.
  Limit_Switch_Max(rc_dig_in05, &pwm03);
  Limit_Switch_Min(rc_dig_in06, &pwm03);
  Limit_Switch_Max(rc_dig_in07, &pwm04);
  Limit_Switch_Min(rc_dig_in08, &pwm04);
  Limit_Switch_Max(rc_dig_in09, &pwm09);
  Limit_Switch_Min(rc_dig_in10, &pwm09);
  Limit_Switch_Max(rc_dig_in11, &pwm10);
  Limit_Switch_Min(rc_dig_in12, &pwm10);
  Limit_Switch_Max(rc_dig_in13, &pwm11);
  Limit_Switch_Min(rc_dig_in14, &pwm11);
  Limit_Switch_Max(rc_dig_in15, &pwm12);
  Limit_Switch_Min(rc_dig_in16, &pwm12);

Limit_Switch_Min and Limit_Switch_Max are functions defined to receive a value of a switch and PWM Output. Defined by the direction of the PWM, if the switch is pressed the PWM Output will not be able to send a value to that direction. For example, we defined that pwm03 controls the arm trim and raises or lowers it. Giving a forward value (above 127) will make the arm go up and a reverse value (under 127) will lower the arm. If the arm rises too high and closes the switch connected to Digital Input 05, pwm03 will receive 127 when given a value more than 127 and the arm will not be able to rise anymore, but it could stay at its current position or descend. Once the arm reaches too low and closes the switch connected to Digital Input 06, pwm03 will receive 127 when given a value fewer than 127 and the arm will not go down, but could stay there or rise. You may vary the limited pwms and their Digital Inputs connected to the limiting switches.
The rest of the code control the Feedback LEDs, all the LED lights on the Operator Interface which you can define when which light will turn on or off, but we suggest not touching it.

That's it for the area that you control your teleoperated mode!

'user_routines_fast.c'

The final explanation of how the autonomous time works is here! The most precious part of the program, the Autonomous Code!

'void User_Autonomous_Code(void)'
The first thing this function does is to initialize all outputs (except for the digital ones) in order to make sure that the outputs aren't stuck with their last values mapped from the joystick. After that, it enters the autonomous loop. (while (autonomous_mode) )

There's a single spot to enter your autonomous code, just after the Getdata function. You need to remember that your robot is supposed to move by it's own and is not controlled by the drivers. You need to code it to do its goal in those 15 seconds it has.

'void Process_Data_From_Local_IO(void)'
This code, as we said when we talked about it when we discussed how main.c works, is a fast loop that doesn't receive any information (and that's why it's fast). You can define any actions here and will do it quicker than the slow loop of Process_Data_From_Mater_uP().
That's it! You should now have the basic knowledge of how the FRC Default Code and you should be ready to start writing your very own code!!!

Time to write your own code!
Hey there Pro! We think it's time for you to write your own code!

We're going to help you and give you some neat tips on how to manage the whole process of programming your robot to do its goals you've defined or will define later.

General programming tips

Tip #1: Always be organized!
Working 6 and a half weeks on making a robot that can do really cool things is a very nerve breaking business unless you take it cool. Know how you want to work. Organize your ideas in one place, write them down, save them in a file or some kind of folder and make sure you keep them, go over them later and make a summarization of all that you thought about, all the opinions you thought about or haven't agreed about yet. Put them in a place that is safe but that you can bring it out easily and quickly. Once you've had your opinions of what you're going to write are complete and summarized, start working on how you're going to do it. Every type of algorithm that you might have dismissed might come to be handy in the future. Keep everything and put them in organized places. 
Make you information easy and available for everyone.

For example, all the projects you've worked on the arm of your robot, put them in a folder defined as "arm", driving methods in "drive" and so on.
Another example, instead of working on a 500 line code trying to figure where is your one single mistake, write batches of codes, like in functions or in separate files.
Tip #2: Never forget anything!

The most annoying thing in programming is you write in a middle of brain-storming a genius algorithm when you are "urgently" pressed to be needed in another place. After putting your mind in another place, you go back to your algorithmic and ask yourself: "Where was I?"
And unless you have a very good memory you most of the times won't be able to answer that question, especially when you have 6.5 weeks of pressure.
When working on something and when you're called to some other place, write notes next to your code before you leave: of what you were thinking about, what do you need to answer, how you thought you might answer, what you will do after you'll answer, all kinds of questions that might come up later and you won't know how to answer them later if you don't remind yourself.

Tip #3: Work cautiously, carefully and even slowly.

Yes, you only have 6.5 weeks, but it's better to have a working code in 100% that isn't the best but won't make any damage than a risky high level code that hasn't been fully tested or been checked in any terms and might do damage.

When you start working on something basic and see you can even add something, STOP THINKING TOO MUCH! Finish what you've decided you will do first, if you had any idea, write it down on the side and keep working on the basic code. You’ve finished? Good. You can now make a copy of the code and work on your new idea. Causing trouble? Good thing you have a basic code that works, or else you would've been stuck hours trying to figure what's that gnarly little mistake that we made.(usually a missing = from the = = when working with 'if' conditions, in our team's case…).

Work one by one, save versions, copy them and work on your upgrades. One by one, step by step. Never take giant leaps unless you're willing to risk falling very deep and having a long journey trying to climb up that hole you've fallen into.

Tip #4: Manage your team.

10 people managing all the code together aren't always effective. 1 man working on the whole code alone isn't effective any much either. Sometimes a programmer can forget something and it's always best to have another programmer next to him checking that he isn't doing any mistake. Work on several actions on the robot but in groups, never alone unless it's something very basic and doesn't need the attention of another fellow programmer in case of mistakes.

Tip #5: Know what is important and what is unimportant.
Make sure your team knows what the primary goals are and what the secondary ones are. Never jump to the secondary. Finish the important. Don't combine working with the Primary goals with the secondary. Every time before you begin, evaluate the goals, how much they are worth and how much time it will take to do it (this also defines the goals worthiness)

Tip #6: Check every case.
Sometimes you'll be working on brilliant things, but sometimes one little thing can make the whole be useless. Like the most annoying cases when, for example, in the 2007 FRC if a tube is stuck on your robot and you can't take it off, it still counts as if you're holding the tube and you can't take another one or you'll get a penalty. So you're actually out of the game. You've worked on a wonderful robot that can do allot and you've been knocked down by a single flaw that can barley happen.

When writing your code, go over your algorithm in all cases and try to foresee any event and try to counter it.

Tip #7: Look for opportunities.
You had this great idea that can really knock down all the other opponents but you can't do it because of certain limitations. As you work on your code, you might get new things and maybe you'll have your chance to bring out your idea and make it possible. Be patient and always look for opportunities wherever they may be.

Tip #8: Be prepared.
After working with your robot on a simulated playing ground, make yourself ready. You might need to work on some slight modifications that will count when you're in the real thing. Be prepared with all the templates and codes that might not have worked before but might suddenly work now. Watch others and try to see if you've missed something while you're working with your robot. You have a practice day. Use it to make your robot fully prepared.

Tip #9: Start dry.
Don't go straight to test your code to see if the robot does its code for real. Use temporary variables and don't give any values to the robot's motors yet. Make sure that there won't be any exceptions or surprises when you give the robot it's code and it suddenly start rolling around the area pulling the computer and who or what not. Test, then check, then when you're sure, put the full code into the robot and give it a try.
And last, but not least, tip #10:
HAVE FUN!!!!
Tips in programming in MPLab
We gave you some general working tips, now comes the real thing. Things we suggest you do when working on MPLab.

Tip #1: Create your own files.
Instead of writing your whole code with other code lines, put it in one place where you know it's your code and you'll be able to handle it by your own. Make a new page, save it as a Source or Header file and add it to your workspace. 

If you don't know the definitions of Header and Source files, here's a little explanation:

Header files - The files where the variables, other Header files and prototypes of functions are defined. Variables and the names of the prototypes of the functions are used in the Source Files with the same name as the Header files name. 
Source files – The files where all the defined functions in the similar Header files are given certain actions to do with the use of the variables defined in the similar Header files and variables defined in the Source file itself. It's where other functions and variables from other Source files are called and used. 

Include the other header files of the functions or macros that you might want to use in your own functions. (I.E, '#include "math.h"' in order to use mathematical functions such as 'sqrt()' for the use of finding the square root of a number).
Wherever you're going to call and use your functions you'll have to add the following include line: '#include "<name of your header file>"'.
When creating your own files, make sure that their name is too long or they'll pass the 64 character limitation MPLab has, meaning if the path of the file is too long, it won't compile it. For example, the path "C:\Program Files\FIRST\team_2230_very_neat_functions_and_structers.c" is too long for the compiler. Make short, yet understandable file names or move your project folder to another path where the path is shorter.
Tip #2: "Comment sava?"

Translated from French, it means "How are you?". Well, how will you feel after 3 weeks when you go back to a previous code you've worked on and you look at it and try to understand what in the world does this code do. 

Enter the commenting. 
With the ability to put unimportant text to the compiler, we can leave a text area just for us, the programmers and others. In this area you can comment about what the function or action is supposed to do. What will happen now, from where this action came from, what is this variable, doing this does what, etc.

If you don't know how to comment, you may add a '//' to the right of your programming line and from that spot on until the next line will take any text inserted there to become a text the compiler will ignore. For example, I want to comment on what will happen when I'll call ' pwm_limitation(pwm_accel(pwm_target,pwm03));'
So, I'm going to add a comment like this:

'pwm_limitation(pwm_accel(pwm_target,pwm03)); //This will accelerate the motor without passing the limit value of 200' (on the same code line)
Or

'pwm_limitation(pwm_accel(pwm_target,pwm03)); 

//This will accelerate the motor without passing the limit value of 200' (code line underneath)
Or

'//This will accelerate the motor without passing the limit value of 200 (code line above)
 pwm_limitation(pwm_accel(pwm_target,pwm03)); '

If you want to try a new method in your code without really ruining any thing, you should delete the code you wrote before. But what if you want to retrieve it and you won't be able to remember how the code went? You can comment a bunch of code lines instead of adding a '//' before each line like this:

/*if(pwm05<=200) 
  {


Pwm05++;

  }*/                        
Increase(pwm05,200);

I commented the 4 lined code and it will not be read by the compiler and underneath, the last code of function 'Increase' is read by the compiler.

A little explanation of how I commented all those code lines: 
The string '/*' begins a commenting of an area of code.
The string '*/' closes the comment area. If you open a comment area without closing it, everything from the opening till the last code line in that file will be commented, so be very careful!

This is it; this is the best we can give you. 

We hope that we were able to give you some basic knowledge on how things work in FRC when using MPLab. We gave you some tips on how to work. But maybe some of you would prefer help while really working on your robots code, meaning real codes and not techniques of how writing real code, but showing you how to do it.

If you'd like that kind of assistance you can always download our example codes that while giving you the code to make your robot work, show you how it makes it work, what you can do by yourself to make it even cooler and can be implemented in any robots code and it would actually work!

To download these codes, go to: www.planetnana.co.il/team2230/downloads.html *note: webpage not up yet!*
We hope that you were able to achieve some level of understanding on how to work with MPLab and we're hoping that you will be able to achieve the main goals you've assigned yourselves in the beginning of the challenge.
Special thanks to our school that supported us with a variety of teachers that helped us understand any difficulties we might have had.

Thank you for FIRST Israel for being there for us and giving us full information about the challenge and helped us be more ready for the competition. 

We'd like to personally thank Alisha Wallenstein, Asaf Menuhin and John the Judge.

We'd like to thank Ranni Retig from the Israel Technion of Haifa up north, who came all the way to Tel Aviv in the center in order to guide us with smarter and better algorithms which led to controlling our robot and putting it in its full potential.
I'd like to personally thank my C and C++ teacher, Amir Kogan, who without his lessons I wouldn't be able to be the lead programmer of the team and manage the programming group and, I'm quite sure, wouldn't be able to make a working robot at all. :)

And last, but not least, to our incredible mentor, Lilach Muzikant, who was there for us all the time and helped guiding our team to the right directions in order to make a working robot and an efficient team. Even all the difficulties we've had, she gave her best to the team and she gave even more than that and all her best was successful. Thank you Lilach!
Me, Team 2230's Programming group and the rest of Team 2230, would like to wish all competing teams and their programmers a successful building process, an amazing experience of learning, thinking and bringing out of ideas that make you, what Dean Cayman said in the 2007 official Kickoff event, "the leaders of tomorrow".
Good luck, have fun and enjoy the spirit of FIRST!

And remember:

ALWAYS BE FIRST!!!
Nir Levanon,

Team Leader, Lead programmer, 2007 GM/Technion Israel Regional robot driver

Team #2230 – Zcharia's Angels
GO TEAM #2230!!!!
